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Features

USB Communication with PC
On-board Microcontroller

On-board Voltage Reference

Evaluation Software

— Register Setup & Chip Control
— FFT Analysis

— Time Domain Analysis

— Noise Histogram Analysis

General Description

The CDB5534U-Z is an inexpensive tool designed to
evaluate the functionality and performance of the
CS5534. The CS5534 datasheet should be read and
consulted when using the CDB5534U-Z evaluation
board.

The evaluation board includes a C8051F320 microcon-
troller with a USB interface. The microcontroller controls
the serial communication between the evaluation board
and the PC via the firmware, enabling quick and easy ac-
cess to all of the CS5534’s registers and functions.

The CDB5534U-Z includes software for Data Capture,
Time Domain Analysis, Histogram Analysis, and Fre-

® Interface Header for External Microcontroller . ;
quency Domain Analysis.
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1. HARDWARE

11 Introduction

The CDB5534U-Z evaluation board provides a quick means of evaluating the CS5534 Analog-to-Digital
Converter (ADC). The CS5534 is a highly integrated A~ ADC which uses charge-balance techniques to
achieve 24-bit performance. The CS5534 includes a very low noise chopper-stabilized instrumentation
amplifier (6 nV/sqgrt(Hz) @ 0.1 Hz) with selectable gains of 1x, 2x, 4x, 8x, 16%, 32x%, and 64x. This ADC
also includes a fourth order AX modulator followed by a digital filter which provides twenty selectable out-
put word rates of 6.25 Hz, 7.5 Hz, 12.5 Hz, 15 Hz, 25 Hz, 30 Hz, 50 Hz, 60 Hz, 100 Hz, 120 Hz, 200 Hz,
240 Hz, 400 Hz, 480 Hz, 800 Hz, 960 Hz, 1.6 kHz, 1.92 kHz, 3.2 kHz and 3.84 kHz (XIN = 4.9152 MHz).

The CDB5534U-Z is shipped with a CS5534 device soldered at U2. However, the CS5531, CS5532, or
CS5533 can be soldered in this same location. The CDB5534U-Z software supports all four devices.

1.2 Evaluation Board Overview

The CDB5534U-Z evaluation board is partitioned into two main sections: analog and digital. The analog
section consists of the CS5534 and a precision voltage reference. The digital section consists of the mi-
crocontroller, the reset circuitry, and the USB interface. The board also has power supply connections
which accommodate all of the various supply options of the CS5534.

The evaluation board’s analog section operates from either a single +5 V, dual 2.5 V, or dual £3 V power
supply. The evaluation board interfaces the CS5534 to an 1IBM® compatible PC with a USB interface. To
accomplish this, the board comes equipped with a microcontroller and a USB cable which physically in-
terfaces the evaluation board to the PC. The software provides easy access to the internal registers of the
CS5534, and provides a means to display and evaluate the performance of the ADC in the time domain
or the frequency domain.

1.2.1 Analog Section

The CS5534 is a high precision AX converter designed to accurately measure up to four fully-differential
analog voltage inputs while operating from a 4.9152 MHz crystal.

The evaluation board provides separate screw terminals to connect signals to each of the four input chan-
nels. The input screw terminals are labeled as AIN1 through AIN4, which correspond to physical input
channels 1 through 4 respectively. A simple RC network on each channel filters the sensor’s output to
reduce any interference picked up by the input leads. The 3 dB corner of the filter is approximately 52 kHz
differential and 56 kHz common mode. Figure 1 illustrates the schematic of the analog section.

The evaluation board provides three voltage reference options for VREF+ and VREF-. The three refer-
ence options for VREF+ include: VA+, the on-board LT1019 voltage reference, and external input (J12).
Table 1 illustrates the options available. With the J17 jumper in position VA+, the reference is supplied by
the VA+ analog supply. With the J17 jumper in position LT1019, the LT1019 provides a +2.5 V reference
(the LT1019 was chosen for its low drift, typically 5ppm/°C). By setting the J17 jumper to position VREF+,
the user can supply an external voltage reference to J12’s VREF+ input.

The three reference options for VREF- include: VA-, GND, and external input (J12). Table 2 illustrates the
options available. With the J18 jumper in position VA-, the reference is supplied by the VA- analog supply.
With the J18 jumper in position GND, the VREF- pin is connected to the board ground. By setting the J18
jumper to position VREF-, the user can supply an external voltage reference to J12’s VREF- input.
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Table 1. Voltage Reference Selection for VREF+

Reference Description J17
Selects Positive VA+ Gum@ VREF+
VA+ Analog Power LT10190 O VREF+
Supply REF+ O O VREF+
Selects on-Board VA+O O VREF+
LT1019 |LT1019Reference | LT1019 Gemid VREF+
(5ppm/°C) REF+ O O VREF+
Selects External VA+O O VREF+
VREF+ |Reference Source | LT1019 O O VREF+
(J12) REF+ Gum® VREF+

Table 2. Voltage Reference Selection for VREF-

Reference Description J18
Selects Negative VA- Gum@ VREF-
VA- Analog Power GND O O VREF-
Supply REF- O O VREF-
lects B VA- O O VREF-
GND Se ec&s doard GND Gmm VREF-
n REF- O O VREF-
Selects External VA-O O VREF-
VREF- |Reference Source GND O O VREF-
(J12) REF- Gem® VREF-

1.2.2 Digital Section

Figure 2 illustrates the schematic of the digital section. It contains the microcontroller, USB interface, EE-
PROM, JTAG header, reset circuitry, and an external interface header. The microcontroller interfaces the
SPI™ and MICROWIRE ™ compatible serial port of the CS5534 with the USB connection to the PC. Note
that the SCLK and SDI signals are level shifted to support both +3.3 V and +5 V digital operation.

The microcontroller EEPROM is used to store firmware. An external interface header, J19, is provided to
allow the CDB5534U-Z to be interfaced with an external microcontroller. To use this serial interface, the
0 ohm resistors R9, R10, R23, and R27 should be removed to disconnect the on-board microcontroller
from the serial interface.

1.2.3 Power Supply Section

Figure 3 illustrates the power supply connections to the evaluation board. VA+ supplies the positive ana-
log supply for the CS5534 and the LT1019 reference. Header J14 allows the VA+ supply to be sourced
from either the VA+ binding post (J2), or from the +5 V binding post (J3). VA- supplies the negative analog
supply for the analog section. Header J13 allows the VA- supply to be sourced from either the VA- binding
post (J1), or connected to the board ground. Note that the VA- supply should be connected to ground
when powering the CDB5534U-Z from a single +5 V analog supply. VD+ supplies the digital section of the
ADC and level shifters. Header J15 allows the VD+ supply to be sourced from the VD+ binding post (J5),
the +5 V binding post (J3), or the regulated +3.3 V supply derived from the microcontroller. The +5 V bind-
ing post supplies the microcontrollers internal regulator.
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2. SOFTWARE

The evaluation board comes with software and a USB cable to link the evaluation board to the PC. The
software is designed to run under Windows® 2000 or later.

2.1 Installation Procedure
2.1.1 CDB5530U GUI Software Installation Instructions
1. Ensure the CDB5534U-Z USB cable is disconnected from the PC.
2. Open GUI software installation folder CDB553x_cvidistkit. Eval5534U => Volume1.
3. Run SETUP.EXE by double clicking on the filename.
4. Select Next, | Accept License Agreement, Next, Next, Finish.
2.1.2 Installing the USB Drivers
1. Apply power to the CDB5534U-Z. Press and release the Reset switch, S1.

2. Use the included USB cable to connect the CDB5534U-Z to the PC. The PC operating system should
automatically launch the Found New Hardware wizard.

3. From the installation wizard, select Install from a list or specific location (Advanced). Select Search
for the best driver in these locations.

Select Include this location in the search.
Click the Browse... button.
Go to folder C./Program Files/Eval5534U/Driver and click OK.

Press the Next button.

© N o o &

A Hardware Installation dialog will appear. Press Continue Anyway.
9. Select Browse... and go to folder C./Program Files/Eval55634U/Driver. Press Open.
10. A Files Needed dialog will appear. Press OK.

11. The Found New Hardware wizard will appear. Press the Finish button.
2.1.3 Running the GUI
Run the program by selecting Start = All Programs = Eval5534U = Eval5534_U.

2.2 Using the Software

Before launching the evaluation program, the user should set up the CDB5534U-Z evaluation board, se-
lect the proper jumper settings as described in Section 1, ensure the board is connected to an open USB
port on the PC, and apply power to the board.

8 DS1257DB1
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2.2.1 Start-Up Window

When the evaluation program is launched, the Start-Up window will appear. This window contains infor-
mation concerning the software’s title, revision number, copyright date, etc.

C5550¢_U Evaluation Software g@

Wwindow  Options  Help  Quit!

B

e —

—— CIRRUS LOGIC

Figure 4. CDB5534U-Z Start-Up Screen

At the top of the screen is a menu bar which displays user options. The menu bar item Window is initially
disabled to prevent conflicts with other serial communications devices. After selecting the data source in
the Options menu, the Window menu item will become available.

2.2.1.1 Options

The Options menu item allows the user to select the source of the data and to configure the appearance
of the graphs. The user has two options for the data source: USB and File. If the USB setup is selected,
the evaluation software will be ready to communicate with the CDB5534U-Z via the USB connection. At
this point, the Part menu item is active and the appropriate CS553x device can be selected. If the File
source is selected, the evaluation software will prompt the user to select the appropriate data file. This
option allows the user to view previously captured data without having a CDB5534U-Z connected to the
PC. See Section 2.5 for more details.

The plot options window can be accessed by pulling down the Options menu and clicking on Plot Options.
In this window, the user can change the background color, the plot line color, and the peak indicator color.
The harmonic and peak indicators can also be turned on or off in this window.

DS1257DB1 9
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2.2.1.2 Window

After the user selects the appropriate setup, the Window option becomes available in the Start-Up win-
dow. The Window pull-down has three options: Start-Up Window, Setup Window, and Data Collection
Window.

2.2.2 Setup Window

The Setup Window allows the user to access the internal registers of the CS5534. See Figure 5.

1ol

wfindow  Options  Help  Quik!

Configuration Register Offset Registers Gain Registers
ﬁ_i Offset 1 HEX: 0 Gain 1 HEX: 1000000
Power Save Select Standby Mode ¥ _
OFfset 2 HEX: 0 Gain 2 HEX: 1000000
Power Down Run w
Reset Spstem r Offset 3 HEX: 0 Gain 3 HEX: 1000000
Reset Valid < Offset 4 HEX: 0 Gain 4 HEX: 1000000
ftermord) Sl —_Momal Calibration Window
Guard Signal Bit AD Dutput Latch ¥
2.5¥ < YREF <=V¥A+ ¥ -
VREF Select £ < : Channel Setup Registers
Dutput Latch Bits (A1, A0) =l
= C5R 1 HEX: 0 C5R 3 HEX: LI}
Output Latch Select  CS Registers %
Dffset/Gain Select  CS1-CS0 Bits ¥ CSR 2 HEX: 0 CSR 4 HEX: 0
Filter R ate Select Mormal i Edit C5Rs I

UPDATE REGS ]

d C5553, A4
= L Setup 1 I Conversion Data Physical
Reset Serial Port 4 0 Channel OverFlow
eset Serial Por I I
Read Data 1 3

Reszet Part I

Figure 5. CDB5534U-Z Setup Window

In the Setup Window, all of the ADC’s registers are displayed as hexadecimal values. The Configuration
Register’s settings are also defined in this window.

Update Registers: The Update Registers button will read all the register values from the CS5534 and
update the hexadecimal values displayed on the screen. It is a good idea to press the Update Registers
button when entering the Setup Window, or after modifying any registers to reflect the current status of
the part.

Reset Serial Port: When this button is selected, the software will send the synchronization sequence dis-
cussed in the CS5534 datasheet to the ADC. This sequence brings the CS5534’s serial port back to the
command mode, but does not reset any of the registers in the part.

Reset Part: \When this button is selected, a ‘1’ is written to the RS bit in the Configuration Register to reset
the part. After a reset, the registers will all return to their default values as discussed in the CS5534 data-
sheet.

Read Data: This button will instruct the ADC to begin performing repeated single (fully-settled) conver-
sions on the setup channel specified by the Setup Register box. The results of the most recent conversion

10 DS1257DB1
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are displayed in the “Last Conversion” box, as well as the Channel and Overflow indicator bits for each
conversion. The software will halt the data collection process when the user selects the Stop button.

Configuration Register: In the Configuration Register box, the contents of the Configuration Register are
displayed, and can be modified by typing a hexadecimal value in the Hexadecimal: box, or by changing
any of the values below the Hexadecimal: box to the desired settings. Note: When changing the value of
the reset system bit to ‘1’ (RS, bit 29 in the Configuration Register), the part will be reset, and all registers
will return to their default values. It is a good idea to select the Update Registers button after performing
a reset to update the screen with the new register values.

Channel Setup Registers: In the Channel Setup Registers box, all four Channel Setup Registers are dis-
played in hexadecimal. These registers can be modified from the Channel Setup Register Window, which
is accessed by selecting the Edit CSRs button.

Channel Setup Register Window: In the Channel Setup Register Window (Figure 6), each of the four
CSRs can be decoded and modified. The blue box at the top of the window allows the user to switch be-
tween CSRs. Each 32-bit CSR contains two 16-bit “Setups” which are decoded in the two boxes below
the hexadecimal value. The currently displayed CSR can be modified by either typing a value directly in
the Hexadecimal: box or by changing the decoded values in the individual Setup boxes.

Channel Setup Register #1 VI

nai: > I

Hex:

Setup 1 Setup 2
Channel Select Channel 1 hd Channel Select Channel 1 hd
Gain Setting 1= v Gain Setting 1= v
‘Word Rate 120 Hz v ‘Word Rate 120 Hz v
Urmipolar/Bipolar Bipolar v Uripolar/Bipolar Bipolar v
Output Latch Bits AD=D Al=0 " Output Latch Bits AD=D Al=0 "
Delay Time Bit Mormal bl Delay Time Bit Mormal bl
Open Ciicuit Detect  Mommal [OF] ¥ Open Circuit Detect  Mommal [OF] ¥
Offset/Gain Select Channel 1 hd Offset/Gain Select Channel 1 hd

Figure 6. CDB5534U-Z Channel Setup Register Window

Offset / Gain Registers: In the Offset Registers / Gain Registers box, the offset and gain registers for all
channels are displayed in hexadecimal. These registers can all be modified in the Calibration Window,
which is accessed when the user selects the Calibration Window button.

Calibration Window: The Calibration Window (Figure 7) permits the user to access the calibration reg-
isters for each channel of the CS5534 and also perform self and system offset or gain calibrations on any
of the channels. Prior to performing calibrations however, the Channel Setup Registers should be modi-
fied to configure the part for the desired operating mode (see the section on the Channel Setup Register

DS1257DB1 11
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Window for more details). Note that offset calibration should be performed before gain calibration to en-
sure accurate results. Refer to the CS5534 datasheet for more details.

OFFSET GAIN GAIN DECODE  Shift Gain Register
Physical Chan 1 j > 1.00000000 Q;I > I
Physical Chan 2 3] 02 1000000 —>  1.00000000 L] o]
Physical Chan 3 3] 0% 1000000 —> 1.00000000 <~ | o |
Physical Chan 4 g 0 ﬂ 1000000 --->  1.00000000 \;I -r I
Perform Calibrations
Self-Offset  System-Offset Self-G ain System-Gain
Setup 1 Vl Setup 1 Vl Setup 1 Vl Setup 1 Vl
[ oone |

Figure 7. CDB5534U-Z Calibration Window
Self Offset or Gain Calibrations:

1) Pull down the Self Offset or Self Gain box, and select the setup number you want to use to cali-
brate the channel.

2) The offset and gain register values will automatically update when the calibration is completed.
System Offset Calibrations:

1) Attach a grounded input to the physical channel you want to calibrate. Note that the grounded input
must be within the common mode range of the particular amplifier (1X-64X) for proper operation.

2) Pull down the System Offset box, and select the setup number you want to use to calibrate the
channel.

3) When the calibration is complete, the screen will automatically update the offset and gain registers
with the new values.

System Gain Calibrations:

1) Attach a full-scale input to the physical channel you want to calibrate.

2) Pull down the System Gain box, and select the setup number you want to use to calibrate the
channel.

3) When the calibration is complete, the screen will automatically update the offset and gain registers
with the new values.

12 DS1257DB1
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2.2.3 Data Collection Window

The Data Collection Window (Figure 8) allows the user to collect sample sets of data from the CS5534
and analyze them using time domain, FFT, and histogram plots. The Data Collection Window is accessi-
ble through the Window option, or by pressing F3.

I3 C55534 Data Collection Window 10| =]

Window  Options  Help  Quik!

| Collect | TIME DOMAIN 'l 10:30:15 | 08-13-2004 |  # of FFT fvgs 0

7-
[

MAXIMUM 2
0

MINIMUM
0 -6
_?_I 1
0.00 16.00
Setup 1 vI SAMPLES 0
Config | Zoom COUNT )
Output | MAGNITUDE i}

Figure 8. CDB5534U-Z Data Collection Window

Time Domain / FFT / Histogram Selector: This menu selects the type of data processing to perform on
the collected data and display in the plot area. Refer to the section on Analyzing Data for more information.

Collect Button: This button will collect data from the part, to be analyzed in the plot area. See the section
on Collecting Data Sets for more information.

Config Button: This button will bring up the configuration window, in which the user can modify the data
collection specifications. See the discussion of the Config Window in this document.

Output Button: This button will bring up a window in which the user can output the data to a data file for
later use, print out a plot, or print out the entire screen.

Zoom Button: This button allows the user to zoom in on the plot by selecting two points in the plot area.
Press the Restore button to return to the normal data plot, or press the Zoom button again to zoom in even
further.

Setup Select Box: This box determines the setup number to use when performing conversions. See the
CS5534 datasheet for more details on the functionality of the Channel Setup Registers.

DS1257DB1 13
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2.2.4 Configuration Window

The Configuration Window allows the user to set up the data collection and analysis parameters. See Fig-
ure 9.

Number of Samples Histogram Bin Width
216 =l

Average FFT Window

£l 2 Hodie (7-term)

Crystal Frequen
Grounded FFT test b/ 5 <

o $4.91520 | MHz
| of

Figure 9. CDB5534U-Z Configuration Window

Number of Samples: This box allows the user to select the number of samples to collect, between 16
and 32,768.

Average: When doing FFT processing, this box will determine the number of FFTs to average. FFTs will
be collected and averaged when the Collect button is pressed.

FFT Window: This box allows the user to select the type of windowing algorithm for FFT processing. Win-
dowing algorithms include the Blackman, Blackman-Harris, Hanning, 5-term Hodie, and 7-term Hodie.
The 5-term Hodie and 7-term Hodie are windowing algorithms developed at Cirrus Logic. This selection
has no effect on Time Domain or Histogram analysis.

Histogram Bin Width: This box allows for a variable "bin width" when plotting histograms of the collected
data. Each vertical bar in the histogram plot will contain the number of output codes contained in this box.
Increasing this number may allow the user to view histograms with larger input ranges.

Crystal Frequency: The CDB5534U-Z evaluation board comes equipped with a 4.9152 MHz crystal. If
the user chooses to replace this with a crystal of a different frequency, the number in this box can be mod-
ified to provide more accurate timing and FFT information.

Grounded FFT Test: \When turned on, this function will generate an ideal full-scale sine wave for calcu-
lation purposes. This will enable the software to calculate the signal-to-distortion and signal-to-noise of
the converter with a simulated ideal full-scale sine wave source, although the converter is grounded.

Accept: When this button is selected, the current settings will be saved, and the user will return to the
Data Collection Window.
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2.3 Collecting Data Sets
To collect a sample data set:

1) In the Data Collection Window, select the Config button to bring up the Configuration Window and
view the current settings.

2) Select the appropriate settings from the available options (see the section on the Configuration
Window) and select the Accept button.

3) The Data Collection Window should still be visible. In the Setup box, select the Setup number you
want to use to perform conversions.

4) Select the Collect button to begin collecting data.

5) Data is sent directly to the PC through the USB cable. Depending on the value of the WR bits in
the selected Setup and the number of samples being collected, this process may take several min-
utes. The process can be terminated by pressing the Stop button, but if this is done, the user
should also press Reset on the CDB5534U-Z board to bring the microcontroller out of the collec-
tion routines.

6) Once the data has been collected, it can be analyzed, printed, or saved to disk.

24 Saving and Printing Data

Once collected, data can be printed or saved to a file for later use. To save or print data, click on the Output
button in the Data Collection Window. A small panel will pop up with three options:

1) Output Data File: Brings up the File Save dialog box, which allows the data to be saved to a file.
2) Print Screen: Prints the entire display, including the calculated statistics.
3) Print Graph: Prints the information in the plot area. The statistical information is not printed.

2.5 Retrieving Saved Data From a File
To load a previously saved file:

1) Pull down the Setup option and select Disk. A file menu will appear.

2) Find the data file in the list and select it. Press the Select button to return.

3) Go to the Data Collection Window, and press the Collect button.

4) The data from the file should appear on the screen. To select a different file, repeat the procedure.

2.6 Analyzing Data

The evaluation software provides three types of analysis - Time Domain, Frequency Domain, and Histo-
gram. The Time Domain analysis processes acquired conversions to produce a plot of conversion sample
number versus magnitude. The Frequency Domain analysis processes acquired conversions to produce
a magnitude versus frequency plot using the Fast-Fourier transform (results up to Fs/2 are calculated and
plotted). Also, performance parameters are also calculated and displayed. The Histogram analysis test
processes acquired conversions to produce a histogram plot. Statistical noise calculations are also calcu-
lated and displayed. For more information on Histograms, refer to Application Note 37.
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2.7 Histogram Information

The following is a description of the indicators associated with Histogram Analysis. Histograms can be plot-
ted in the Data Collection Window by setting the Time Domain / FFT / Histogram selector to Histogram.
BIN: Displays the x-axis value of the cursor on the Histogram.

MAGNITUDE: Displays the y-axis value of the cursor on the Histogram.

MAXIMUM: Indicator for the maximum value of the collected data set.

MEAN: Indicator for the average of the data sample set.

MINIMUM: Indicator for the minimum value of the collected data set.

STD. DEV.: Indicator for the Standard Deviation of the collected data set.

VARIANCE: Indicates the Variance for the current data set.

2.8 Frequency Domain Information

The following describe the indicators associated with FFT (Fast Fourier Transform) Analysis. FFT data
can be plotted in the Data Collection Window by setting the Time Domain / FFT / Histogram selector to FFT.
FREQUENCY: Displays the x-axis value of the cursor on the FFT display.

MAGNITUDE: Displays the y-axis value of the cursor on the FFT display.

S/D: Indicator for the Signal-to-Distortion Ratio, 4 harmonics are used in the calculations (decibels).
S/N+D: Indicator for the Signal-to-Noise + Distortion Ratio (decibels).

SNR: Indicator for the Signal-to-Noise Ratio, first 4 harmonics are not included (decibels).

S/PN: Indicator for the Signal-to-Peak Noise Ratio (decibels).

# of AVG: Displays the number of FFT’s averaged in the current display.

29 Time Domain Information

The following controls and indicators are associated with Time Domain Analysis. Time domain data can
be plotted in the Data Collection Window by setting the Time Domain / FFT / Histogram selector to Time
Domain.

COUNT: Displays current x-position of the cursor on the time domain display.

MAGNITUDE: Displays current y-position of the cursor on the time domain display.

MAXIMUM: Indicator for the maximum value of the collected data set.

MINIMUM: Indicator for the minimum value of the collected data set.
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Figure 11. Top Side Layout
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REVISION HISTORY

Revision Date Changes

DB1 NOV 2019 Initial release, formerly CDB5534U_DS289DB6.

Contacting Cirrus Logic Support
For a complete listing of Direct Sales, Distributor, and Sales Representative contacts, visit the Cirrus Logic web site at:
http://www.cirrus.com

IMPORTANT NOTICE

The products and services of Cirrus Logic International (UK) Limited; Cirrus Logic, Inc.; and other companies in the Cirrus Logic group (collectively
either “Cirrus Logic” or “Cirrus”) are sold subject to Cirrus Logic’s terms and conditions of sale supplied at the time of order acknowledgment, including
those pertaining to warranty, indemnification, and limitation of liability. Software is provided pursuant to applicable license terms. Cirrus Logic reserves
the right to make changes to its products and specifications or to discontinue any product or service without notice. Customers should therefore obtain
the latest version of relevant information from Cirrus Logic to verify that the information is current and complete. Testing and other quality control
techniques are utilized to the extent Cirrus Logic deems necessary. Specific testing of all parameters of each device is not necessarily performed. In
order to minimize risks associated with customer applications, the customer must use adequate design and operating safeguards to minimize inherent
or procedural hazards. Cirrus Logic is not liable for applications assistance or customer product design. The customer is solely responsible for its
product design, including the specific manner in which it uses Cirrus Logic components, and certain uses or product designs may require an intellectual
property license from a third party. Customers are responsible for overall system design, and system security. While Cirrus Logic is confident in the
performance capabilities of its components, it is not possible to provide an absolute guarantee that they will deliver the outcomes or results envisaged
by each of our customers. Features and operations described herein are for illustrative purposes only and do not constitute a suggestion or instruction
to adopt a particular product design or a particular mode of operation for a Cirrus Logic component.

CERTAIN APPLICATIONS USING SEMICONDUCTOR PRODUCTS MAY INVOLVE POTENTIAL RISKS OF DEATH, PERSONAL INJURY, OR SEVERE
PROPERTY OR ENVIRONMENTAL DAMAGE (“CRITICAL APPLICATIONS”). CIRRUS LOGIC PRODUCTS ARE NOT DESIGNED, AUTHORIZED OR
WARRANTED FOR USE IN PRODUCTS SURGICALLY IMPLANTED INTO THE BODY, AUTOMOTIVE SAFETY OR SECURITY DEVICES, NUCLEAR
SYSTEMS, LIFE SUPPORT PRODUCTS OR OTHER CRITICAL APPLICATIONS. INCLUSION OF CIRRUS LOGIC PRODUCTS IN SUCH APPLICATIONS IS
UNDERSTOOD TO BE FULLY AT THE CUSTOMER’S RISK AND CIRRUS LOGIC DISCLAIMS AND MAKES NO WARRANTY, EXPRESS, STATUTORY OR
IMPLIED, INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR PARTICULAR PURPOSE, WITH REGARD TO ANY
CIRRUS LOGIC PRODUCT THAT IS USED IN SUCH A MANNER. IF THE CUSTOMER OR CUSTOMER'’S CUSTOMER USES OR PERMITS THE USE OF
CIRRUS LOGIC PRODUCTS IN CRITICAL APPLICATIONS, CUSTOMER AGREES, BY SUCH USE, TO FULLY INDEMNIFY CIRRUS LOGIC, ITS OFFICERS,
DIRECTORS, EMPLOYEES, DISTRIBUTORS AND OTHER AGENTS FROM ANY AND ALL LIABILITY, INCLUDING ATTORNEYS' FEES AND COSTS, THAT
MAY RESULT FROM OR ARISE IN CONNECTION WITH THESE USES.

This document is the property of Cirrus Logic, and you may not use this document in connection with any legal analysis concerning Cirrus Logic
products described herein. No license to any technology or intellectual property right of Cirrus Logic or any third party is granted herein, including but
not limited to any patent right, copyright, mask work right, or other intellectual property rights. Any provision or publication of any third party’s products
or services does not constitute Cirrus Logic’s approval, license, warranty or endorsement thereof. Cirrus Logic gives consent for copies to be made of
the information contained herein only for use within your organization with respect to Cirrus Logic integrated circuits or other products of Cirrus Logic,
and only if the reproduction is without alteration and is accompanied by all associated copyright, proprietary and other notices and conditions (including
this notice). This consent does not extend to other copying such as copying for general distribution, advertising or promotional purposes, or for creating
any work for resale. This document and its information is provided “AS IS” without warranty of any kind (express or implied). All statutory warranties
and conditions are excluded to the fullest extent possible. No responsibility is assumed by Cirrus Logic for the use of information herein, including use
of this information as the basis for manufacture or sale of any items, or for infringement of patents or other rights of third parties. Cirrus Logic, Cirrus,
the Cirrus Logic logo design, and SoundClear are among the trademarks of Cirrus Logic. Other brand and product names may be trademarks or service
marks of their respective owners.

Copyright © 2007-2019 Cirrus Logic, Inc. and Cirrus Logic International Semiconductor Ltd. All rights reserved.Windows is a registered trademark of Microsoft
Corporation.

SPI is a trademark of Motorola, Inc.
Microwire is a trademark of National Semiconductor Corporation.
IBM is a registered trademark of International Business Machines Corporation.
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